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Question Number : 1 Question Id : 2549896429 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The multiplication arithmetic operator is represented by which of the following symbols in the C programming language?
Options :
1.  ^
2.  *
3.  /
4.  ×
  
Question Number : 1 Question Id : 2549896429 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
C �ो�ािमंग ल��ेज म� गुणन अंकगिणतीय ऑपरेटर को िन�िल�खत म� से िकस �तीक �ारा दशा�या जाता है?
Options :
1.  ^
2.  *
3.  /
4.  ×
  
Question Number : 2 Question Id : 2549896436 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT an example of embedded software based functions?
Options :
1.  Image processing systems found in medical imaging equipment
2.  Internet browsers
3.  Fly-by-wire control systems found in aircraft
4.  Traffic control systems found in traffic lights
  
Question Number : 2 Question Id : 2549896436 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सा ए�ेडेड सॉ�वेयर (embedded software) आधा�रत काय� का उदाहरण नही ंहै?
Options :
1.  िचिक�ा इमेिजंग उपकरण म� पाई जानेवाली छिव �सं�रण �णाली
2.  इंटरनेट �ाउज़र
3.  िवमान म� पाई जानेवाली �ाई-बाय-वायर कंट� ोल िस�म
4.  ट� ै िफक लाइट म� पाए जाने वाले ट� ै िफक कंट� ोल िस�म
  
Question Number : 3 Question Id : 2549896890 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The keys labeled 0-9 on the computer keyboard are called ______ keys.
Options :
1.  function
2.  special purpose
3.  typewriter
4.  number / numeric
  
Question Number : 3 Question Id : 2549896890 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
कं�ूटर कीबोड� पर 0-9 लेबल वाली कीज़ को �ा कहा जाता है?
Options :
1.  फं�न कीज़
2.  �ैशल पप�स कीज़
3.  टाइपराइटर कीज़
4.  नंबर / �ूमे�रक (number / numeric) कीज़
  
Question Number : 4 Question Id : 2549896943 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0



Which of the following is the primary output device for a computer?
Options :
1.  Monitor
2.  Printer
3.  Keyboard
4.  Mouse
  
Question Number : 4 Question Id : 2549896943 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन� म� से कं�ूटर के िलए �ाथिमक आउटपुट िडवाइस �ा है?
Options :
1.  मॉिनटर
2.  ि��र
3.  कीबोड�
4.  माउस
  
Question Number : 5 Question Id : 2549897295 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following operating systems does NOT support New Technology File System (NTFS)?
Options :
1.  Windows NT 4.0
2.  Windows NT 3.5
3.  Windows Me
4.  Windows 2000
  
Question Number : 5 Question Id : 2549897295 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सी ऑपरेिटंग िस�म �ू टे�ोलॉजी फाइल िस�म (NTFS) का समथ�न नही ंकरती है?
Options :



1.  Windows NT 4.0
2.  Windows NT 3.5
3.  Windows Me
4.  Windows 2000
  
Question Number : 6 Question Id : 2549897319 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The computer program that allocates the system resources and coordinates all the details of the computer's internals is called the ______ in
UNIX.
Options :
1.  shell
2.  compiler
3.  kernel
4.  system library
  
Question Number : 6 Question Id : 2549897319 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
कं�ूटर �ो�ाम जो िक �णाली के संसाधनो ंका िनयतन करते ह� और कं�ूटर के अ�र के सभी िववरणो ंको सम�ियत करते ह�, उ�� यूिन� (UNIX) म�
______ कहा जाता है।
Options :
1.  शेल्
2.  क�ाइलस�
3.  कन�ल
4.  िस�म लाइ�ेरी
  
Question Number : 7 Question Id : 2549897589 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ is the computer memory that is accessible to the central processing unit of a computer without the use of computer's input/output
channels.



Options :
1.  Primary storage
2.  Secondary storage
3.  Flash memory
4.  USB memory
  
Question Number : 7 Question Id : 2549897589 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ कं�ूटर मेमोरी है जो कं�ूटर के इनपुट/आउटपुट चैनलो ंके उपयोग के िबना िकसी कं�ूटर के स�ट� ल �ोसेिसंग यूिनट के िलए प�ंच यो� (accessible)
है।
Options :
1.  �ाइमरी �ोरेज
2.  सेक� डरी �ोरेज
3.  �ैश मेमोरी
4.  USB मेमोरी
  
Question Number : 8 Question Id : 2549897626 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following computer generation uses the concept of artificial intelligence?
Options :
1.  Fourth Generation
2.  Second Generation
3.  Third Generation
4.  Fifth Generation
  
Question Number : 8 Question Id : 2549897626 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is Question
Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सी कं�ूटर पीढ़ी कृि�म बु��म�ा की अवधारणा का उपयोग करती है?
Options :



1.  चौथी पीढी
2.  दूसरी पीढी
3.  तीसरी पीढ़ी
4.  पांचवी ंपीढ़ी
  
Question Number : 9 Question Id : 25498929961 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The popular mechanism of recognising the identity of a living person based on a physiological or behavioral characteristic is:
Options :
1.  biometric device
2.  automatic device
3.  audiometric device
4.  videometric device
  
Question Number : 9 Question Id : 25498929961 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
कािय�की (शारी�रक) या �भावज� (�वहार संबंधी) िवशेषता के आधार पर जीिवत ��� की पहचान के िलए आम तौर पर काम म� ली जाने वाली यं�-रचना
कौन-सी होती है?
Options :
1.  बायोमेिट� क उपकरण
2.  �चािलत उपकरण
3.  ऑिडयोमेिट� क उपकरण
4.  वीिडयोमेिट� क उपकरण
  
Question Number : 10 Question Id : 25498930212 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What is the wavelength of a Blu-ray Disc?
Options :



1.  405 nm
2.  650 nm
3.  600 nm
4.  780 nm
  
Question Number : 10 Question Id : 25498930212 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
� लू-रे िड� क का वेवल�थ (तरंगदै��) िकतना होता है?
Options :
1.  405 nm
2.  650 nm
3.  600 nm
4.  780 nm
  
Question Number : 11 Question Id : 25498930638 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What is the responsibility of the Logical Unit in the CPU of a computer?
Options :
1.  Comparing numbers
2.  Printing result
3.  Controlling flow of information
4.  Controlling flow of data
  
Question Number : 11 Question Id : 25498930638 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
कं�ूटर के CPU म� लॉिजकल यूिनट का �ा काम होता है?
Options :
1.  सं�ाओ ंकी तुलना करना



2.  प�रणाम देना
3.  सूचना के �वाह को िनयंि�त करना
4.  डेटा के �वाह को िनयंि�त करना
  
Question Number : 12 Question Id : 25498930704 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
A blog is a type of ______.
Options :
1.  Web browser
2.  Stage
3.  Layer
4.  Website
  
Question Number : 12 Question Id : 25498930704 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
�ॉग एक �कार का/की ______ है।
Options :
1.  वेब �ाउज़र
2.  �ेज
3.  लेयर
4.  वेबसाइट
  
Question Number : 13 Question Id : 25498933174 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Nibble interleaving or multiplexing takes a ______ from a lower-speed channel as input for a multiplexed signal on a higher-speed channel.
Options :
1.  nibble
2.  byte



3.  word
4.  dword
  
Question Number : 13 Question Id : 25498933174 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िनबल इंटरलीिवंग या ब�संकेतन (म�ी�े��ंग) म� ती� चैनल पर ब�संकेतक िस�ल के िलए इनपुट के �प म�, एक लोअर �ीड चैनल से ______ िलया जाता
है।
Options :
1.  िनबल
2.  बाइट
3.  वड�
4.  ड् वॉड�
  
Question Number : 14 Question Id : 25498933725 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What is a non-invasive imaging technology using magnetic fields that produces three dimensional detailed anatomical images used for disease
detection, diagnosis and treatment monitoring called?
Options :
1.  ECG
2.  X-Ray
3.  Magnetic Resonance Imaging (MRI)
4.  Ultrasound
  
Question Number : 14 Question Id : 25498933725 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
चंुबकीय �े� का उपयोग करने वाली एक गैर-इनवेिसव इमेिजंग तकनीक �ा कहलाती है जो रोग का पता लगाने, िनदान और उपचार की िनगरानी हेतु उपयोग
की जाने वाली तीन आयामी िव�ृत संरचना�क छिवयो ं(images) का उ�ादन करती है?
Options :
1.  ईसीजी (ECG)



2.  ए�-रे (X-Ray)
3.  चंुबकीय अनुनाद इमेिजंग (MRI)
4.  अ�� ासाउंड (Ultrasound)
  
Question Number : 15 Question Id : 25498933811 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What is the colour depth of a graphics card to generate true colour?
Options :
1.  4 bit
2.  8 bit
3.  16 bit
4.  24 bit
  
Question Number : 15 Question Id : 25498933811 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
वा�िवक रंग उ�� करने के िलए �ािफ� काड� की कलर डे�थ िकतनी होती है?
Options :
1.  4 िबट
2.  8 िबट
3.  16 िबट
4.  24 िबट
  
Question Number : 16 Question Id : 2549896193 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In MS Word, a character that is raised and is smaller above the baseline is known as:
Options :
1.  Raised
2.  Superscript



3.  UPPERCASE
4.  lowercase
  
Question Number : 16 Question Id : 2549896193 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word म�, एक वण� (कैरे�र) जो आधार रेखा से ऊपर उठा होता है और छोटा होता है, उसे �ा कहा जाता है?
Options :
1.  रेइ�ड (Raised)
2.  सुपर��� (Superscript)
3.  अपरकेस (UPPERCASE)
4.  लोअरकेस (lowercase)
  
Question Number : 17 Question Id : 2549896194 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The ______ enables your computer to connect to other computers or to the internet.
Options :
1.  video card
2.  sound card
3.  network interface card (NIC)
4.  controller card
  
Question Number : 17 Question Id : 2549896194 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ आपके कं�ूटर को अ� कं�ूटरो ंया िफर इंटरनेट से जोड़ने म� मदद करता है।
Options :
1.  िविडयो काड�
2.  साउंड काड�
3.  नेटवक�  इंटरफ़ेस काड� (NIC)



4.  कंट� ोलर काड�
  
Question Number : 18 Question Id : 2549896256 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ is when the more power-hungry components, such as the monitor and the hard drive, are put in idle.
Options :
1.  Log off
2.  Power down
3.  Standby mode
4.  The shutdown procedure
  
Question Number : 18 Question Id : 2549896256 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ तब होता है, जब �ादा ऊजा� की खपत वाले िह�े, जैसे िक मॉिनटर या हाड� ड� ाइव, बंद पड़ जाते ह�।
Options :
1.  लॉग ऑफ
2.  पावर डाउन
3.  ��डबाय मोड
4.  शटडाउन की �ि�या
  
Question Number : 19 Question Id : 2549897907 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
C++, a programming language that supports Object Oriented Programming, was developed by ______.
Options :
1.  Bjarne Stroustrup
2.  Pito Salas
3.  Linus Torvald
4.  Guiddo Von Rossum



  
Question Number : 19 Question Id : 2549897907 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
C++, एक �ो�ािमंग भाषा है, जो ऑ�े� ओ�रएंटेड �ो�ािमंग को सपोट� करती है, ______ �ारा िवकिसत की गई थी।
Options :
1.  बजेन� �� ॉ�� प
2.  िपटो सालास
3.  लाइनस टॉरवा�्स
4.  गुइडो वॉन रोसुम
  
Question Number : 20 Question Id : 2549898198 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In terms of computer security, ANI stands for:
Options :
1.  Automatic Number Identification
2.  Auto Notification Information
3.  Auto Number Information
4.  Auto Name Information
  
Question Number : 20 Question Id : 2549898198 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
कं�ूटर सुर�ा के संदभ� म�, ANI का पूण� �प �ा है?
Options :
1.  ऑटोमैिटक नंबर आईड��िटिफ़केशन (Automatic Number Identification)
2.  ऑटो नोिटिफ़केशन इंफॉम�शन (Auto Notification Information)
3.  ऑटो नंबर इंफॉम�शन (Auto Number Information)
4.  ऑटो नेम इंफॉम�शन (Auto Name Information)
  



Question Number : 21 Question Id : 2549898562 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which file format is used to save a video file?
Options :
1.  .mp3
2.  .avi
3.  .jpg
4.  .ec3
  
Question Number : 21 Question Id : 2549898562 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
वीिडयो फाइल को सेव करने के िलए िकस फाइल फॉम�ट का उपयोग िकया जाता है?
Options :
1.  .mp3
2.  .avi
3.  .jpg
4.  .ec3
  
Question Number : 22 Question Id : 2549898888 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
When we start our computer, _______ is the first software that runs.
Options :
1.  BIOS
2.  CD
3.  HDD
4.  FDD
  
Question Number : 22 Question Id : 2549898888 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0
जब हम अपना कं�ूटर शु� करते ह�, तो चलने वाला पहला सॉ�वेयर _______ होता है।
Options :
1.  BIOS
2.  CD
3.  HDD
4.  FDD
  
Question Number : 23 Question Id : 2549899419 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Where is the print option in menu bar of MS Word located?
Options :
1.  Insert → Print
2.  File → Print
3.  Home → Print
4.  Data → Print
  
Question Number : 23 Question Id : 2549899419 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Word के मेनू बार म� ि�ंट िवक� कहाँ ��थत है?
Options :
1.  Insert → Print
2.  File → Print
3.  Home → Print
4.  Data → Print
  
Question Number : 24 Question Id : 2549899555 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT the interface to connect the printer?



Options :
1.  USB
2.  Wi-Fi
3.  Fibre optics
4.  Serial port
  
Question Number : 24 Question Id : 2549899555 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
ि�ंटर को संयोिजत करने के िलए िन� म� से कौन सा इंटरफ़ेस नही ंहै?
Options :
1.  यूएसबी (USB)
2.  वाई-फाई (Wi-Fi)
3.  फाइबर ऑि�� (Fibre optics)
4.  सी�रयल पोट� (Serial port)
  
Question Number : 25 Question Id : 25498910814 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is a line printer?
Options :
1.  Dot-matrix printer
2.  Ink-jet printer
3.  Drum printer
4.  Laser jet printer
  
Question Number : 25 Question Id : 25498910814 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन सा लाइन ि�ंटर है?
Options :



1.  डॉट मैिट� � ि�ंटर
2.  इंकजेट ि�ंटर
3.  ड� म ि�ंटर
4.  लेजर जेट ि�ंटर
  
Question Number : 26 Question Id : 25498911609 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is the smallest visual element that can be displayed and represented on a digital display device?
Options :
1.  Pixel
2.  Resistor
3.  Bit
4.  Circuit
  
Question Number : 26 Question Id : 25498911609 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सा सबसे छोटा �� त� है िजसे िडिजटल िड��े िडवाइस पर �दिश�त तथा िन�िपत िकया जा सकता है?
Options :
1.  िप�ेल
2.  रिज�र
3.  िबट
4.  सिक� ट
  
Question Number : 27 Question Id : 25498913375 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In which generations of computer Vaccum Tubes was used?
Options :
1.  Fifth



2.  First
3.  Third
4.  Fourth
  
Question Number : 27 Question Id : 25498913375 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
कं�ूटर की िकस पीढ़ी म� वै�ूम �ूब (Vaccum Tubes) का उपयोग िकया जाता था?
Options :
1.  पांचवी
2.  पहली
3.  तीसरी
4.  चौथी
  
Question Number : 28 Question Id : 25498918422 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What is a default printer?
Options :
1.  It is a printer that prints all the jobs unless another printer is specified by the user.
2.  It is a printer that prints specific jobs unless another printer is specified by the user.
3.  It is a printer that prints all the jobs and user cannot change the printer.
4.  It is a special printer designed for special purposes.
  
Question Number : 28 Question Id : 25498918422 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िडफ़ॉ� ि�ंटर �ा है?
Options :
1.  यिद उपयोगकता� �ारा िकसी अ� ि�ंटर को िनिद�� न िकया गया हो तो यह ि�ंटर सभी काय� (जॉब) का मु�ण (ि�ंट) करता है।
2.  यिद उपयोगकता� �ारा िकसी अ� ि�ंटर को िनिद�� न िकया गया हो तो यह ि�ंटर िवशेष काय� (जॉब) का मु�ण (ि�ंट) करता है।



3.  यह सभी काय� का मु�ण करता है और उपयोगकता� ि�ंटर बदल नही ंसकता।
4.  यह िविश� उ�े� से बनाया गया एक िविश� ि�ंटर है।
  
Question Number : 29 Question Id : 25498918426 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Printer is a/an ______ device:
Options :
1.  input
2.  output
3.  network interface
4.  internet provider
  
Question Number : 29 Question Id : 25498918426 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
ि�ंटर एक ______ उपकरण है।
Options :
1.  इनपुट
2.  आउटपुट
3.  नेटवक�  इंटरफ़ेस
4.  इंटरनेट �ोवाइडर
  
Question Number : 30 Question Id : 25498918572 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In Red Hat Enterprise Linux, which of the following two partitions are among the recommended ones?
Options :
1.  Swap and Main
2.  Root and Swap
3.  Root and System



4.  Main and System
  
Question Number : 30 Question Id : 25498918572 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Red Hat Enterprise Linux म�, िन�िल�खत म� से कौन से दो पाट�शन अनुशंिसत पाट�शन होते ह�?
Options :
1.  �ैप और मेन
2.  �ट और �ैप
3.  �ट और िस�म
4.  मेन और िस�म
  
Question Number : 31 Question Id : 2549896222 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is the communication protocol that sets the standard used by every computer that accesses Web-based information?
Options :
1.  XML
2.  DML
3.  HTTP
4.  HTML
  
Question Number : 31 Question Id : 2549896222 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन-सा संचार �ोटोकॉल है जो वेब-आधा�रत जानकारी को ए�ेस करने वाले ��ेक कं�ूटर �ारा उपयोग िकए जाने वाले मानक को सेट करता है?
Options :
1.  XML
2.  DML
3.  HTTP
4.  HTML



  
Question Number : 32 Question Id : 2549896627 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The program that you run on the computer is first transferred to which memory before it is actually run?
Options :
1.  Auxiliary memory
2.  Primary memory
3.  Secondary memory
4.  Tertiary memory
  
Question Number : 32 Question Id : 2549896627 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
कं�ूटर पर रन िकए जाने वाले �ो�ाम को वा�व म� रन करने से पहले िन� म� से िकस मेमोरी म� �थानांत�रत िकया जाता है?
Options :
1.  सहायक मेमोरी 
2.  �ाथिमक मेमोरी 
3.  ि�तीयक मेमोरी 
4.  तृतीयक मेमोरी 
  
Question Number : 33 Question Id : 2549896985 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Most mail programs automatically complete the following two parts in an e-mail:
Options :
1.  From: and Body:
2.  From: and Date:
3.  From: and To:
4.  From: and Subject:
  
Question Number : 33 Question Id : 2549896985 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is



Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
अिधकांश मेल �ो�ाम ई-मेल म� �चािलत �प से िन�िल�खत म� िकस दो भागो ंको पूरा करते ह�?
Options :
1.  From: और Body:
2.  From: और Date:
3.  From: और To:
4.  From: और Subject:
  
Question Number : 34 Question Id : 2549897164 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ is a library of public domain works.
Options :
1.  Wikilib
2.  Wikihouse
3.  Wikisource
4.  Wikihome
  
Question Number : 34 Question Id : 2549897164 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ साव�जिनक डोमेन काय� की एक लाइ�ेरी है।
Options :
1.  िविकिलब
2.  िविकहाउस
3.  िविकसोस�
4.  िविकहोम
  
Question Number : 35 Question Id : 2549897408 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0
By using which option can one add a heading in an MS-Word 2013 document?
Options :
1.  Styles
2.  Font
3.  Paragraph
4.  Clipboard
  
Question Number : 35 Question Id : 2549897408 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Word 2013 डॉ�ुम�ट म�, िकस िवक� का उपयोग करके कोई शीष�क को जोड़ सकता है?
Options :
1.  �ाइ�
2.  फॉ�
3.  पैरा�ाफ
4.  ��पबोड�
  
Question Number : 36 Question Id : 2549897870 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following sections does NOT exist in the Home tab in MS-PowerPoint 2013?
Options :
1.  Clipboard
2.  Lists
3.  Font
4.  Paragraph
  
Question Number : 36 Question Id : 2549897870 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-PowerPoint 2013 म�, होम टैब म� िन� म� से कौन-सा अनुभाग मौजूद नही ंहै?



Options :
1.  ��पबोड�
2.  िल�
3.  फॉ�
4.  पैरा�ाफ
  
Question Number : 37 Question Id : 2549898121 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which statement is INCORRECT in case of doughnut chart in MS Excel?
Options :
1.  It shows the relationship of the parts to a whole.
2.  Because of their circular nature, doughnut charts are not easy to read.
3.  It displays the data in rings, where each ring represents a data series.
4.  It is used to illustrate the fluctuation of stock prices.
  
Question Number : 37 Question Id : 2549898121 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS Excel म� डोनट (doughnut) चाट� के मामले म� िन�िल�खत म� से कौन-सा कथन गलत है?
Options :
1.  यह पूण� से भागो ंका संबंध दशा�ता है।
2.  उनके वृ�ीय �कृित के कारण, डोनट चाट� को पढ़ना आसान नही ंहोता है।
3.  यह डेटा को �रंगो ंम� �दिश�त करता है, जहां ��ेक �रंग एक डेटा �ंृखला को िन�िपत करती है।
4.  इसका उपयोग �ॉक की कीमतो ंम� उतार-चढ़ाव को दशा�ने के िलए िकया जाता है।
  
Question Number : 38 Question Id : 25498910530 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Word gives you two ways to set the options to change the page size: through the ribbon menus and ______.
Options :



1.  dialog boxes
2.  text boxes
3.  list boxes
4.  radio buttons
  
Question Number : 38 Question Id : 25498910530 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Word आपको पेज आकार बदलने के िलए िवक�ो ंको सेट करने हेतु दो तरीके �दान करता है: �रबन मेनू और ______ के मा�म से।
Options :
1.  डायलॉग बॉ�
2.  टे� बॉ�
3.  िल� बॉ�ेस
4.  रेिडयो बटन
  
Question Number : 39 Question Id : 25498910603 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What do you understand by line spacing?
Options :
1.  It describes about the width of the characters.
2.  It is a fixed unit of measurement representing the height of characters.
3.  It refers to the distance between the baselines of each line of text.
4.  It is a representation of dots.
  
Question Number : 39 Question Id : 25498910603 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
लाइन � पेिसंग से आप �ा समझते ह�?
Options :
1.  यह वण� की चौड़ाई के बारे म� बताता है।



2.  यह वण� की ऊंचाई िन�िपत करने वाली माप की एक िनि�त इकाई है।
3.  यह ��ेक टे� लाइन की आधार रेखाओ ंके बीच की दूरी को संदिभ�त करता है।
4.  यह िबंदुओ ंका िन�पण है।
  
Question Number : 40 Question Id : 25498911439 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In MS-Word 2010, if you type the word 'wednesday' it would automatically change it to 'Wednesday'. To control this behavior in Word, the steps
are given below in a jumbled order. Arrange them in a proper order.

1. Make sure the AutoCorrect tab is selected.
2. Choose AutoCorrect (AutoCorrect Options in some versions of Word) from the Tools menu. Word displays the AutoCorrect dialog box.
3. Select or deselect the Capitalize Names of Days check box, depending on whether you want Word to automatically capitalise for you.
4. Click on OK.
Options :
1.  2, 1, 3, 4
2.  2, 1, 4, 3
3.  2, 3, 1, 4
4.  1, 2, 3, 4
  
Question Number : 40 Question Id : 25498911439 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Word 2010 म�, यिद आप 'wednesday' श� टाइप करते ह�, तो यह �चािलत �प से 'Wednesday' म� बदल जाएगा। Word म� इस �वहार को िनयंि�त
करने के िलए, यहां चरण अ�व��थत �म म� िदए ह�। उ�� उिचत �म म� �व��थत कर�।

1. सुिनि�त कर�  िक ओटो करे� टैब चुना गया है।
2. टूल मेनू से ओटो करे� (Word के कुछ सं�रणो ंम� ओटो करे� िवक�) चुन�। Word ओटो करे� संवाद बॉ� �दिश�त करता है।
3. Word �चािलत �प से आपके िलए कैिपटलाइज़ करे या नही,ं इस आधार पर िदन के नामो ंको कैिपलाइज़ करने के चेक बॉ� को चयन कर�  या चयन र�
कर� ।
4. ओके पर ��क कर�।
Options :
1.  2,1,3,4
2.  2,1,4,3



3.  2,3,1,4
4.  1,2,3,4
  
Question Number : 41 Question Id : 25498911818 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is a sequence of instructions written using a computer programming language to perform a specified task by the
computer?
Options :
1.  Algorithm
2.  Pseudo code
3.  Flow chart
4.  Computer program
  
Question Number : 41 Question Id : 25498911818 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सा, कं�ूटर �ारा एक िनिद�� काय� को करने के िलए कं�ूटर �ो�ािमंग भाषा का उपयोग करके िलखे गए िनद�शो ंका एक �म है?
Options :
1.  अ�ो�रथम
2.  �ूडो कोड
3.  �ो चाट�
4.  कं�ूटर �ो�ाम
  
Question Number : 42 Question Id : 25498911901 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
To select or clear all check boxes for all reviewers in the list of Show Markup, click the ______ feature in MS-Word 2016.
Options :
1.  comments
2.  insertions and deletions
3.  all reviewers



4.  no reviewers
  
Question Number : 42 Question Id : 25498911901 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
शो माक� अप की सूची म� सभी समी�को ंके िलए सभी चेक बॉ� को चुनने (select) या ��यर (clear) करने के िलए, MS-Word 2016 म� ______ फीचर पर
��क कर�।
Options :
1.  कम�ट्स
2.  इंसश�न और िडलीशन
3.  ऑल �र�ूअर
4.  नो �र�ूअर
  
Question Number : 43 Question Id : 25498911923 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
We can manually select the spacing of the columns by clicking the _______ option in the columns drop down menu in MS-Word 2013.
Options :
1.  Customize columns
2.  More columns
3.  Control columns
4.  Insert columns
  
Question Number : 43 Question Id : 25498911923 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Word 2013 म� कॉलम ड� ॉप डाउन मेनू म� _______ िवक� पर ��क करके हम कॉलम की �ेिसंग को मै�ुअल �प से चुन सकते ह�।
Options :
1.  क�माइज कॉलम
2.  मोर कॉलम
3.  कंट� ोल कॉलम



4.  इ�ट� कॉलम
  
Question Number : 44 Question Id : 25498911951 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Rebecca is working on an MS-Word 2003 document. In order to enable the gutter between the columns, she has to choose ______ from the Page
Layout tab.
Options :
1.  columns
2.  gutter
3.  tab
4.  space
  
Question Number : 44 Question Id : 25498911951 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
रेबेका MS Word 2003 डॉ�ूम�ट पर काम कर रही है। कॉलम के बीच म� गटर (gutter) को इनेबल करने के िलए, उसे पेज लेआउट टैब से ______ को चुनना
होगा।
Options :
1.  कॉलम
2.  गटर (gutter)
3.  टैब
4.  �ेस
  
Question Number : 45 Question Id : 25498913318 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following is a software that is used to write computer programs?
Options :
1.  Interpreter
2.  Compiler
3.  Text editor



4.  Debugger
  
Question Number : 45 Question Id : 25498913318 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत म� से कौन-सा एक सॉ�वेयर है िजसका उपयोग कं�ूटर �ो�ाम िलखने के िलए िकया जाता है?
Options :
1.  इंटर�ेटर
2.  क�ाइलर
3.  टे� एिडटर
4.  डीबगर
  
Question Number : 46 Question Id : 25498919148 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The given icon is present in the ______ group in the mailing tab in MS-Word 2007.

Options :
1.  Create
2.  Start mail merge
3.  Preview result
4.  Finish
  
Question Number : 46 Question Id : 25498919148 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Word 2007 म� नीचे िदया गया आइकन मेिलंग टैब के िकस समूह म� मौजूद रहता है?



Options :
1.  ि�एट (Create)
2.  �ाट� मेल मज� (Start mail merge)
3.  �ी�ू �रज� (Preview result)
4.  िफिनश (Finish)
  
Question Number : 47 Question Id : 25498919222 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The given icon is displayed when the ______ radio button is enabled in the third step of mail merging the letter in MS-Word 2016.

Options :
1.  Use Existing List
2.  Select from Outlook Contacts
3.  Type New List



4.  Import the List
  
Question Number : 47 Question Id : 25498919222 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Word 2016 म�, उपरो� आइकन तब �दिश�त होता है जब लेटर की मेल मिज�ग (merging) के तीसरे चरण म� ______ रेिडयो बटन एनेबल (enabled) होता
है।

Options :
1.  मौजूदा सूची का उपयोग कर�  (Use Existing List)
2.  आउटलुक संपक� को चुन� (Select from Outlook Contacts)
3.  एक नई सूची टाइप कर�  (Type New List)
4.  सूची इ�ोट� कर�  (Import the List)
  
Question Number : 48 Question Id : 25498919249 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In MS-Word 2016, if we want to change the rotation options during printing of an envelope in the mail merge process, here are the steps.
Fill the '?' with a suitable answer.



? 
Create 
Envelope options 
Printing options 
Clockwise rotation
Options :
1.  Mailings
2.  References
3.  Page Layout
4.  Design
  
Question Number : 48 Question Id : 25498919249 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Word 2016 म�, यिद हम मेल मज� (merge) �ि�या म� िलफाफे के ि�ंिटंग के दौरान रोटेशन िवक�ो ंको बदलना चाहते ह� तो उसके िलए िन�िल�खत चरण
है।
'?' को उपयु� उ�र के साथ भर� ।

? 
बनाना 
िलफ़ाफ़ा िवक� 
ि�ंिटंग िवक� 
दि�णावत� घूण�न
Options :
1.  मेिलंग
2.  रेफरे�ेस
3.  पेज लेआउट
4.  िडजाइन
  
Question Number : 49 Question Id : 25498924869 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
______ are useful for quickly creating unweighted cross tabulations in MS-Excel.



Options :
1.  Macros
2.  Charts
3.  Functions
4.  Pivot tables
  
Question Number : 49 Question Id : 25498924869 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
MS-Excel म�, ______, अभा�रत �ॉस टे�ुलेशन को ज�ी से बनाने के िलए उपयोगी ह�।
Options :
1.  मै�ो
2.  चाट�
3.  फं��
4.  िपवट टेब�
  
Question Number : 50 Question Id : 25498925511 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following are NOT commonly formatted as superscript?
Options :
1.  Ordinal numerals
2.  Copyright symbols
3.  Chemical sysmbols
4.  Icons
  
Question Number : 50 Question Id : 25498925511 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन� म� से कौन-सा, आमतौर पर सुपर��� के �प म� ��िपत नही ंहोता है?
Options :



1.  ऑिड�नल नुमेर�
2.  कॉपीराइट िस�ॉ�
3.  केिमकल िस�ॉ�
4.  आइकॉ�
  
Question Number : 51 Question Id : 25498932138 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Read the following statement carefully and choose the appropriate option.

Videoconferencing involves the use of video cameras connected to two or more computers.
Options :
1.  True
2.  False
3.  May be
4.  Can’t determine
  
Question Number : 51 Question Id : 25498932138 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत कथन को �ान से पढ़�  और उपयु� िवक� चुन�।

िविडयो कॉ�रे��ंग म� दो या अिधक कं�ूटरो ंसे जुड़े वीिडयो कैमरो ंका उपयोग शािमल है।
Options :
1.  स�
2.  अस�
3.  कदािचत
4.  िनधा��रत नही ंकर सकते
  
Question Number : 52 Question Id : 25498934489 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0



A circuit board through which all the components of a computer communicate is called the:
Options :
1.  Central Processing Unit
2.  Graphic Processing Unit
3.  motherboard
4.  Random Access Memory
  
Question Number : 52 Question Id : 25498934489 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
एक सिक� ट बोड� िजसके मा�म से कं�ूटर के सभी घटक संचार करते ह�, कहलाता ह�:
Options :
1.  स�ट� ल �ोसेिसंग यूिनट
2.  �ािफ़क �ोसेिसंग यूिनट
3.  मदरबोड�
4.  र�डम ए�ेस मेमोरी
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Question Id : 25498920839 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Question Numbers : (53 to 57)
Read the given passage and answer the questions.

Keep your Dream

This is the story of a boy named Monty Roberts, who owns a horse ranch in San Ysidro. He was the son of an itinerant horse trainer who would
go from stable to stable, race track to race track, farm to farm and ranch to ranch, training horses. As a result, the boy’s high school career was
continually interrupted.

When he was a senior, he was asked to write a paper about what he wanted to be and do when he grew up. That night he wrote a seven page-
paper about his dream in great detail and he even drew a diagram of a 200-acre ranch, showing the location of all the buildings, stables and the
track. Then he drew a detailed floor plan for a 4,000 square foot house that would sit on a 200 acre dream ranch.

He put a great deal of his heart into the project and the next day he handed it in to his teacher. Two days later he received his paper back. On the
front page was a large red F with a note that read, ‘See me after class.' The boy with the dream went to see the teacher after class and asked,
‘Why did I get an F ?’. The teacher said, ‘This is an unrealistic dream for a young boy like you. You have no money, no resources. Owning a
horse ranch requires a lot of money. You have to buy the land, pay for the original breeding stock and pay large stud fees. There is no way you
could ever do it. If you rewrite this paper with a more realistic goal, I will reconsider your grade’.

The boy went home and thought about it long and hard. He consulted his father as well. Finally, after sitting with it for a week, the boy turned in
the same paper, making no changes at all. He told the teacher, ‘You can keep the F and I will keep my dream….’

Time passed. One summer the same school teacher brought 30 kids to camp out on Monty’s ranch for a week and while leaving the teacher said,
‘Look Monty, I can tell you this now. When I was your teacher, I feel like I stole a lot of kids’ dreams. Fortunately, you were brave, had strong
will power and therefore succeeded.'
Sub questions
 
Question Number : 53 Question Id : 25498920840 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What interrupted Monty's school education?
Options :
1.  Lack of sufficient money.
2.  His father's sudden illness.



3.  The itinerant nature of his father's job.
4.  Inability to join a good school.
 
Question Number : 54 Question Id : 25498920841 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What did Monty want to do when he grew up?
Options :
1.  Be an expert horse trainer like his father.
2.  Own a 200 acre horse ranch.
3.  Be a veterinary surgeon.
4.  Own a 200 acre farmland.
 
Question Number : 55 Question Id : 25498920842 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What does the detailed seven page assignment indicate about Monty?
Options :
1.  Monty's intense passion about his ambition.
2.  His love for open fields and stables.
3.  His desire to be a jockey.
4.  His wish to be an excellent horse-breeder.
 
Question Number : 56 Question Id : 25498920843 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Why did his teacher give Monty such a poor grade?
Options :
1.  She thought that he was being very unrealistic and unaware of the enormous costs involved.
2.  She wanted to nip in the bud his desire to be a ranch owner.
3.  She considered it her duty to tell him the truth.
4.  She especially enjoyed destroying the dream of others.
 



Question Number : 57 Question Id : 25498920844 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What did the teacher learn from Monty?
Options :
1.  It is rude to kill other people's dream.
2.  Money is not the only ingredient for success.
3.  Persistence and self-confidence are as important as money.
4.  One must have a dream to live for.
  
Question Id : 25498920839 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Question Numbers : (53 to 57)
िदए गए ग�ांश को पढ़�  और उसके आधार पर ��ो ंके उ�र द�।

अपने सपनो ंको सहेज कर रख�

यह मॉ�ी रॉबट्�स नाम के एक लड़के की कहानी है, जो सैन यिस�ो म� अ�बल का मािलक है। वह एक यायावर घोड़े के ट� ेनर का पु� था जो घोड़ो ंको �िशि�त
करने के िलए एक अ�बल से दुसरे अ�बल, रेस ट� ैक म�, र�चो ंम� तथा खेतो ंम� जाता था। नतीजतन, लड़के का हाई �ूल कै�रयर लगातार बािधत �आ। 

जब वह सीिनयर था, तो उसे एक पेपर म� यह िलखने के िलए कहा गया था िक वह बड़ा होकर �ा बनना चाहता है। उस रात उसने अपने सपनो ंके बारे म� सात
पेज म� िव�ार पूव�क िलखा- एक िव�ृत िववरण म� उसने 200 एकड़ के अ�बल का िच� लगाया, िजसम� सभी िब��ंग, अ�बल और ट� ैक का �थान िदखाया
गया था। िफर उसने एक 4,000 वग� फुट के घर के िलए एक िव�ृत �ोर �ान बनाया, जो 200 एकड़ म� बने उसके सपनो ंके भ� अ�बल के बीच म� बना
होगा।

उ�ों�न ेइस प�रयोजना के बारे म� पूरे लगन से काम िकया और अगले िदन उ�ों�ने इसे अपने िश�क को सौपं िदया। दो िदन बाद उ�� अपना पेपर वापस िमला।
सामने वाले पृ� पर लाल रंग म� एक बड़ा सा ‘एफ़’ िलखा था और साथ म� एक नोट िलखा �आ था 'क�ा के बाद मुझसे िमलो।' लड़का �ास के बाद अपने टीचर
से िमलने गया और पूछा, 'मुझे एफ �ो ंिमला?' िश�क ने कहा, 'यह आपके जैसे युवा लड़के के िलए एक अवा�िवक सपना है। आपके पास पैसा नही ंहै, कोई
संसाधन नही ंहै। अ�बल के मािलक के पास ब�त पैसा होना चािहए। आपको जमीन खरीदनी है, मूल �ीिडंग �ॉक के िलए भुगतान करना है और अिधक �ड
फीस का भुगतान करना है। ऐसा कोई तरीका नही ंहै िक आप इसे कभी भी कर सक� । यिद आप इस पेपर म� और यथाथ�वादी ल�ो ंको िफर से िलखते ह�, तो म�
आपके �ेड के बारे म� पुनिव�चार क�ंगा।

लड़का घर गया और इसके बारे म� ब�त देर तक सोचा। उसने अपने िपता से भी इसके बारे म� सलाह मशिवरा िकया। अंत म�, एक स�ाह िवचार करने के बाद,
उसने उस पेपर म� बदलाव नही ंिकया। उसने िश�क से कहा, 'आप अपना ‘एफ’ रख सकते ह� और म� भी अपने सपने को सहेज कर रखँूगा...'



व� िनकल गया। गिम�यो ंम� उसी �ूल के िश�क 30 ब�ो ंको एक स�ाह के िलए मॉ�ी के अ�बल पर ले गए और िश�क ने जाते समय कहा, 'मॉ�ी मेरी
बात सुनो, म� तुमको यह बता सकता �ं िक जब म� तु�ारा िश�क था, मुझे लगता है िक म��ने ब�त सारे ब�ो ंके सपनो ंको चुरा िलया। सौभा� से, तुम बहादुर थे,
इसिलए �बल इ�ा श�� होने के कारण तु�ारा सपना साकार �आ।'
Sub questions
 
Question Number : 53 Question Id : 25498920840 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
मॉ�ी की �ूल िश�ा म� �ा बाधा आई?
Options :
1.  पैसे की कमी।
2.  उनके िपता की अचानक बीमारी।
3.  अपने िपता के नौकरी की यायावर �कृित।
4.  अ�े �ूल म� शािमल होने म� असमथ�ता।
 
Question Number : 54 Question Id : 25498920841 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
जब वह बड़ा �आ तो मॉ�ी �ा करना चाहता था?
Options :
1.  अपने िपता की तरह ही मािहर (ए�पट�) हॉस� ट� ेनर बनना चाहता था।
2.  200 एकड़ अ�बल का मािलक बनना चाहता था।
3.  पशु िचिक�ा सज�न बनना चाहता था।
4.  200 एकड़ कृिष भूिम का मािलक बनना चाहता था।
 
Question Number : 55 Question Id : 25498920842 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िव�ृत सात पेज का असाइनम�ट मॉ�ी के बारे म� �ा बताता है?
Options :
1.  मॉ�ी की मह�ाकां�ा के बारे म� गहन जुनून।
2.  ओपन फ़ी� और अ�बल से उनका �ार।



3.  जॉकी बनने की उनकी इ�ा।
4.  उनकी इ�ा एक उ�ृ� हॉस�-�ीडर बनने की थी।
 
Question Number : 56 Question Id : 25498920843 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
उसके िश�क ने मॉ�ी को इतना कम �ेड �ो ंिदया?
Options :
1.  िश�क को लगा की वह ब�त अवा�िवक बन रहा था और वह जो एक ब�त �ादा लगत की ज�रत है उसके बारे म� अनिभ� था।
2.  वह अ�बल के मािलक बनने की उसकी इ�ा का �ाग करना चाहता था।
3.  उसने उससे सच बोलना अपना कत�� माना।
4.  उसे िवशेष �प से दूसरो ंके सपने को टूटते �ए देखने म� मजा आता था।
 
Question Number : 57 Question Id : 25498920844 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िश�क ने मॉ�ी से �ा िसखा?
Options :
1.  दूसरे लोगो ंके सपने को मारना अिश� है।
2.  पैसा सफलता के िलए एकमा� घटक नही ंहै। 
3.  �ढ़ता और आ�िव�ास उसी �कार मह�पूण� है जैसे िक पैसा। 
4.  जीवन म� हर िकसी का एक सपना होना चािहए। 
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Question Number : 58 Question Id : 25498914198 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
24 men can complete a piece of work in 15 days. 2 days after the 24 men started working, 4 men left the work. How many more days will the
remaining men take to complete the remaining work?
Options :

1.  

2.  

3.  

4.  

  
Question Number : 58 Question Id : 25498914198 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
24 ��� िकसी काय� को 15 िदन म� पूरा कर सकते ह�। 24 ���यो ं�ारा काय� शु� करने के 2 िदन बाद 4 ��� काय� छोड़ कर चले गए। शेष काय� को बचे
�ए ��� और िकतने िदनो ंम� पूरा कर ल�गे?
Options :

1.  



2.  

3.  

4.  

  
Question Number : 59 Question Id : 25498914243 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 59 Question Id : 25498914243 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0



Options :

1.  

2.  

3.  

4.  

  
Question Number : 60 Question Id : 25498914265 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 60 Question Id : 25498914265 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0



Options :

1.  

2.  

3.  

4.  

  
Question Number : 61 Question Id : 25498914311 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  
Question Number : 61 Question Id : 25498914311 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0



Options :

1.  

2.  

3.  

4.  

  
Question Number : 62 Question Id : 25498914338 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.   

  
Question Number : 62 Question Id : 25498914338 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is



Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.   

  
Question Number : 63 Question Id : 25498929166 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  

  



Question Number : 63 Question Id : 25498929166 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :

1.  

2.  

3.  

4.  
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Question Number : 64 Question Id : 25498910043 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Which of the following words will come second if all of them are arranged alphabetically as in a dictionary?
Options :
1.  Biscuits
2.  Bifurcate
3.  Bicycle
4.  Bitter
  
Question Number : 64 Question Id : 25498910043 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
चार श� िदये गये ह�। यिद सभी श�ो ंको एक श�कोश के अनुसार वणा�नु�म म� �व��थत िकया जाता है, तो दूसरे �थान पर कौन सा श� आयेगा?
Options :
1.  Biscuits
2.  Bifurcate
3.  Bicycle
4.  Bitter
  
Question Number : 65 Question Id : 25498910127 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Select the option that is related to the third term in the same way as the second term is related to the first term.

Furniture : Wood :: Cloth : ?
Options :
1.  Costume
2.  Dress
3.  Tailor
4.  Fabric



  
Question Number : 65 Question Id : 25498910127 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
उस िवक� को चुने जो तीसरे पद से उसी �कार से संबंिधत है िजस �कार से दूसरा पद पहले पद से संबंिधत है।

फन�चर : लकड़ी :: कपड़ा : ?
Options :
1.  कॉ��ूम
2.  ड� ेस
3.  दज�
4.  कपड़ा
  
Question Number : 66 Question Id : 25498912837 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Instruction: Study the following arrangement of letters, digits and symbols to answer the question given below.

↑ 9 A F = $ 2 5 R J  L 3 @ Y M E 6 8 * ÷ D F 4 β H 7 ©

Question: How many such symbols are there in the above arrangement each of which is either immediately followed by a number or immediately
preceded by a letter?
Options :
1.  One
2.  Two
3.  Three
4.  Four
  
Question Number : 66 Question Id : 25498912837 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
अनुदेश: िदये गये �� का उ�र देने के िलए अ�रो,ं अंको ंऔर �तीको ंकी िन�िल�खत �व�था को �ानपूव�क पढ़�।

↑ 9 A F = $ 2 5 R J  L 3 @ Y M E 6 8 * ÷ D F 4 β H 7 ©



सवाल: उपरो� �व�था म� िकतने ऐसे �तीक ह� िजनके तुरंत बाद म� या तो एक सं�ा है या तुरंत पहले एक अ�र है?
Options :
1.  एक
2.  दो
3.  तीन
4.  चार
  
Question Number : 67 Question Id : 25498912897 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :
1.  CEJT
2.  EGLO
3.  EGLP
4.  RTWZ
  
Question Number : 67 Question Id : 25498912897 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0

Options :
1.  CEJT
2.  EGLO
3.  EGLP
4.  RTWZ



  
Question Number : 68 Question Id : 25498919653 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
In the following question, some words are given which are related in some way. The same relationship is there obtains among the words in one of
the four alternatives given under it. Select the appropriate option.

Horse : Foal : Mare
Options :
1.  Sheep : Lamp : Goat
2.  Lion : Cub : Den
3.  Man : Child : House
4.  Bull : Calf : Cow
  
Question Number : 68 Question Id : 25498919653 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िन�िल�खत �� म�, कुछ ऐसे श� िदए गए ह� जो िकसी �प म� एक-दूसरे से संबंिधत ह�। नीचे िदए गए चार िवक�ो ंम� से एक म� श�ो ंके बीच वही संबंध है जो
नीचे िदए श�ो ंके बीच है। सही िवक� का पता लगाएं।

Horse : Foal : Mare
Options :
1.  Sheep : Lamp : Goat
2.  Lion : Cub : Den
3.  Man : Child : House
4.  Bull : Calf : Cow
  
Question Number : 69 Question Id : 25498919725 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Mr. Johnson was to earn ₹ 300 and a free holiday for seven weeks’ work. He worked for only 4 weeks and earned ₹ 30 and free holiday. What
was the value of the holiday?
Options :



1.  ₹ 300
2.  ₹ 330
3.  ₹ 360
4.  ₹ 420
  
Question Number : 69 Question Id : 25498919725 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
�ीमान जॉनसन सात स�ाह के काम के िलए ₹ 300 और एक मु� छुि� कमाने वाले थे। उ�ों�ने केवल 4 स�ाह तक काम िकया और ₹ 30 और मु� छुि�
अिज�त की। छुि� का मू� �ा था?
Options :
1.  ₹ 300
2.  ₹ 330
3.  ₹ 360
4.  ₹ 420
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Question Number : 70 Question Id : 2549895244 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
“Invisible export” means export of:
Options :
1.  services
2.  prohibited goods
3.  unrecorded goods
4.  goods through smuggling
  
Question Number : 70 Question Id : 2549895244 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
"अ�� िनया�त" का �ा अथ� है?
Options :
1.  सेवाओ ंके िनया�त
2.  �ितबंिधत व�ुओ ंके िनया�त
3.  िबना �रकाड� की व�ुओ ंका िनया�त
4.  त�री के मा�म से व�ुओ ंका िनया�त
  
Question Number : 71 Question Id : 2549895287 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
What are the terms ‘Nivi, Paridhan and Adhivasa' used for?
Options :
1.  Different types of garments of the Aryans
2.  Government officials of the Aryan Kings
3.  Tribal people of Ancient Indians
4.  Musical instrument of Ancient Indians
  
Question Number : 71 Question Id : 2549895287 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0
श� ‘िनवी, प�रधान और अिधवासा’ िकसके िलए �योग िकए जाते ह�?
Options :
1.  आय� के िविभ� �कार के व�ों
2.  आय� राजाओ ंके सरकारी अिधकारी
3.  �ाचीन भारतीयो ंके आिदवासी लोग
4.  �ाचीन भारतीयो ंका संगीत वा�यं�
  
Question Number : 72 Question Id : 2549895401 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Who is known as father of Zoology?
Options :
1.  Darwin
2.  Lamarck
3.  Aristotle
4.  Theophrastus
  
Question Number : 72 Question Id : 2549895401 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
�ािणिव�ान या ज�ुिव�ान के िपता के �प म� िकसे जाना जाता है?
Options :
1.  डािव�न
2.  लैमाक�
3.  अर�ू
4.  िथयो�े�स
  
Question Number : 73 Question Id : 2549895961 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0



What did the Muslim deputation meet Lord Minto in 1906 at Shimla for? (under the leadership of Aga Khan)
Options :
1.  Separate electorate for Muslims
2.  A composite Electorate
3.  Higher representation of the Hindus
4.  Special representation of Muslims by nomination
  
Question Number : 73 Question Id : 2549895961 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
िशमला म� 1906 म� मु��म �ितिनिधयो ंने लॉड� िमंटो से मुलाकात �ो ंकी थी? (आगा खान के नेतृ� म�)
Options :
1.  मुसलमानो ंके िलए पृथक िनवा�चन �े�
2.  एक संयु� िनवा�चन �े�
3.  िहंदूओ ंका उ� �ितिनिध�
4.  नामांकन के �ारा मुसलमानो ंको िवशेष �ितिनिध�
  
Question Number : 74 Question Id : 2549899638 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
Per Capital Income of a country is derived from:
Options :
1.  National Income
2.  Population
3.  National Income and Population both
4.  Gross national income
  
Question Number : 74 Question Id : 2549899638 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
देश की �ित ��� आय िन�िल�खत म� से िकस से �ा� की जाती है?
Options :



1.  रा�� ीय आय
2.  जनसं�ा
3.  रा�� ीय आय एवं जनसं�ा दोनों
4.  सकल रा�� ीय आय
  
Question Number : 75 Question Id : 2549899649 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
The growth rate of Per Capita Income at current prices is higher than that of Per Capita Income at constant prices, because the latter takes into
account the rate of:
Options :
1.  growth of population
2.  increases in price level
3.  growth in money supply
4.  increases in the wage rate
  
Question Number : 75 Question Id : 2549899649 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes Is
Question Mandatory : No Calculator : None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0
Correct Marks : 1 Wrong Marks : 0
वत�मान मू�ो ंकी �ित ��� आय का वृ�� दर, ��थर मू�ो ंपर �ित ��� आय से अिधक होता है, �ों�िक परवत� उ���खत मू� म�, ______ दर पर गणना
की जाती है।
Options :
1.  जनसं�ा की वृ��
2.  मू� के �र म� वृ��
3.  धनरािश की आपूित� म� वृ��
4.  मज़दूरी दर म� वृ��
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Question Number : 76 Question Id : 25498941117 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
Summer camps are supervised camps conducted to entertain as well as equip students with various life skills such as teamwork,
socializing, decision making, independent and responsible living and more. It aids the overall development of a child and children have
fun during this process as they get to explore new arenas.
Restricted/ Unrestricted : Unrestricted
Paragraph Display : Yes
Keyboard Layout : Inscript



Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes
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Group Maximum Duration : 15
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Show Attended Group? : No
Edit Attended Group? : No
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Group Marks : 0
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Sub-Section Number : 1
Sub-Section Id : 2549895548
Question Shuffling Allowed : No
  
Question Number : 77 Question Id : 25498937900 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
Junk food simply means an empty calorie food. An empty calorie food is high calorie or calorie rich food which lacks in micronutrients
such as vitamins and minerals or amino acids but has high energy quotient. These foods do not contain the nutrients that our body needs
to stay healthy. Junk food is an informal term applied to some foods which are perceived to have little or no nutritional value but which
also have ingredients considered unhealthy when eaten regularly or to those considered unhealthy to consume at all. The term Junk food
was coined as slang term in the public interest by Michael Jacobson Director of the Centre for Science Washington DC. The terms fast
food and junk food are often used interchangeably. These foods contain high levels of refined sugar and polyunsaturated and trans fats.
Various food additives such as monosodium glutamate and tartrazine are also used. At the same time it is lacking in fibres among other
healthy attributes. These foods have little enzyme producing vitamins and minerals. Junk food culture has a vigorously uprising trend
among youngsters and it makes people eat without planning. They eat not only during preset mealtime but also in the leisure time. Junk
food seems convenient as it is very easy to prepare and consume. Generally junk food is given a very attractive appearance by adding
food additives and colours. These artificial additives and preservatives along with an enhanced flavour also guarantee a long shelf life of
the product. Common junk food includes fast food such as burgers and pizzas as well as aerated beverages. Heavily processed
ingredients of the junk foods make them addictive in nature and encourage binge eating which poses many health hazards. The
chemicals used in the packaging materials can seep into the meals. Multiple factors may influence the consumption of junk food. Studies
among adolescents suggest that marketing strategies and low prices all may play an influential role. It is known that food preferences
develop in childhood. These dietary behaviours continue into adulthood and increase the risks of chronic diseases later in life. The early
stages in the juvenility of teens represent a crucial period of transition in the overall human development. The total nutrient needs are
higher during this stage of growth than in any other stage of the life cycle. It is also the time when a boy or girl increases their social
interactions with their peers and develop different eating habits. It is a stage when they are least bothered about what they eat. Currently
fast food and junk food have expanded their sales in schools. For many students the day is not complete without observing the daily
ritual of visiting the junk food shop in and around the school premises. Awareness on junk food facts is lacking dramatically in every
corner of the society. Ninety percent of parents agree that junk food advertisements were making it difficult for them to promote healthy
eating at home. Messages for healthy eating are getting undermined at every turn by the relentless number of junk food advertisements.
Hence each and every individual parent needs to be educated about such foods and their impact on their children health that can take
care to avoid them intelligently and keeping them out of the reach of their children.
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Question Number : 78 Question Id : 25498944355 Question Type : TYPING TEST Display Question Number : Yes Calculator : None

ै औ



एक बार की बात है, अकबर और बीरबल िशकार पर जा रहे थे। अभी कुछ समय की उ�� एक िहरण िदखा। ज�बाजी म� तीर िनकालते �ए अकबर
अपने हाथ पर घाव लगा बैठा। अब हालात कुछ ऐसे थे की अकबर ब�त दद� म� था और गु�े म� भी।
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समय की बबा�दी आजकल मनोरंजन के नाम पर भी ब�त होती है। रेिडयो, िसनेमा, खेलतमाशे, ताश, शतरंज आिद म� हम िन� ही अपना ब�तसा
समय बबा�द करते रहते ह�। महा�ा गांधी ने एक बार अपने पु� मिणलाल को प� म� िलखकर कहा था िक खेलकूद मनोरंजन का समय बारह वष� की
उ� तक ही है। आज हम इसम� अपना िकतना व� खच� करते ह� यह �यं ही अनुमान लगा सकते ह�। मनोरंजन खेल आिद को जीवन म� केवल मन
को एकरसता से मु� करने के िलए ही रखा जाना चािहए और यह �ान रखा जाना चािहए िक हमारा मनोरंजन उ�ृ� �र का हो और तनमन दोनो ं
के िलए �ा��द हो, और उसके िलए भी एक िनयत समय रखना चािहये। अपने आसपास का वातावरण, ऐसा रखना चािहए िक अपना समय
िकसी कारण बबा�द न हो। व� बबा�द करने वाले दो�ो ंसे दूर की नम�े रखनी चािहए। िनठ�े लोग ही अ�र दूसरे का व� बबा�द करने जा
प�ंचते ह�। इ�� दो� नही ंदु�न मानना ही उिचत है। �रण र�खये समय ब�त मू�वान व�ु है। इससे आप िजतना लाभ उठा सकते ह� उठाय�।
आप व� को न� कर� गे तो व� भी आपको न� कर देगा। व� के सदुपयोग पर ही आप कुछ बन सकते ह�। समय बडा मू�वान है। उसे बडी
कंजूसी से खच� करना चािहए। िजतना अपने समयधन को बचाकर उसे आव�क उपयोगी कामो म� लगाव�गे उतनी ही अपने ���� की मह�ा एवं
कीमत अिधक होती जायगी। िनयिमत समय पर काम करने का अ�ास डाल�। इसकी आदत हो जाने पर आपको �यं ही इसम� आन� आने लगेगा।
यिद मनु� �ितिदन िकसी काम िवशेष म� अ� समय भी लगाव� तो वह उसपर मह�पूण� अिधकार �ा� कर सकता है। महामनीषी �ेटमाड�न ने
कहा है, जीवन भर एक िवषय म� िनयिमत �प से �ितिदन एक घ�ा लगाने वाला ��� उस िवषय का िवशेष� बन सकता है। समय को मामूली न
समझ� िनयिमत �प से कोई भी काम आप कर� गे तो धीरेधीरे उसम� ब�त बडी यो�ता हािसल कर ल�गे यह िनि�त है। जरा िवचार कीिजये आपको
अमुक िदन अमुक ट� ेन से ब�ई जाना है। अगर आप ट� ेन के सीटी देने के एक िमनट बाद �ेशन प�ंचे तो िफर आपको वह ट� ेन, वह िदन, वह समय
कभी नही ंिमलेगा। िनि�त समय िनकल जाने के बाद आप िकसी जगह म� जाय� तो िनि�त है आपका काम नही ंहोगा। अपने काम और समय का इस
तरह मेल रख� िक उसम� एक िमनट का भी अ�र न आये। तभी आप अपने समय का पूरापूरा सदुपयोग कर सक� गे। आल� समय का सबसे िवकट
श�ु है। यह कई �पो ंम� मनु� पर अपना अिधकार जमा लेता है। कई बार कुछ काम िकया िक िव�ाम के बहाने हम अपने समय को बरबाद करने
लगते ह�। वैसे बीमारी, तकलीफ आिद म� िव�ाम करना तो आल� नही ंहै। थक जाने पर नीदं के िलये िव�ाम करना भी बुरा नही ंहै। थकावट हो, नीदं
आये तो तुर� सो जाय� लेिकन आंख खुलने पर उठबैठ�  और काम म� लग जाएं। अभी उठते ह�, अभी उठते ह�, कहते रह� तो यही आल� का म� है।
आंख� खुली ंिक तुर� अपने काम म� लग जाय�।
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